
INTRODUCTION

This handout is to be read in conjunction with the IT Lab User Guide and the Guide to Outlook.

Aims: 
After working through this handout you should be able to

· Log on and off the XP system

· Send and receive email

· Achieve simple file handling tasks using XP

· Load, compile, execute and edit a Java program using the eclipse IDE. 

· Locate and correct syntax errors in a Java program
Please ask

Please ask a tutor or demonstrator if these instructions are not clear : they are there to help you.

Logging on

You must have the sheet with your XP username and password.

Follow the logging on instructions in the IT Lab User Guide.

Logging off

Work through as much of this sheet as you can – when you are ready to leave the lab please don’t just walk away : refer to the Logging Off instructions in the IT Lab guide.

Send and receive email messages

Ask your neighbour for their user name.  Follow the instructions in the Guide to Outlook, to send an email message to your neighbour.  When you receive a message, follow the instructions to read it and reply to it.

Programming : A Hello World Program

In this exercise you learn how to use the eclipse IDE.  These notes are based on eclipse version 3.2.  If you are confused, ask for help.  Eclipse is free and you can download and install it on your own machine.  The Java development environment is also free and must be downloaded and installed before installing Eclipse.  Guidance on how to do this is provided at the end of this document.

Starting Eclipse

Double clicking the eclipse icon will bring up the eclipse initial screen:
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The tooltip shows which button you should click to go to the workbench.  The workbench is where you do all of your programming.  Clicking on this button brings up the workbench screen.
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There are four main parts to the workbench:


-
The section in the middle is where you write your program.


-
The section at the bottom is where your output and error messages appear.


-
The section on the left lists all your projects and the files in each project.


-
The section on the right provides details of the program file that is selected.

Your Workspace

A workspace is a folder where all your eclipse related files are stored.  You can copy your files from your workspace in the lab to your workspace at home if you are using eclipse at home.  It is also a good idea to copy your files on a USB drive after each lab session anyway.  This will backup your work and safeguard against any loss of files.

You can see where your workspace is located by clicking on the File menu and choosing the Switch Workspace... option.  You will get the following screen:
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Click Cancel once you have noted where your files are stored.  If you want to use another folder for your workspace then you can select it using the Browse... button.  The folder must already exist.

Creating a Project

Each different programming task is called a project, so the next step is to create a project.  Go to the File menu, select New and then Project.   There are a number of different types of project to choose from, but the one you want, Java Project, should be highlighted, as shown.  If not, select it yourself.
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Click Next to bring up the project definition screen.
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You need to fill in a project name, Lab1Ex1, for example.  I have already filled it in in the above screen shot.  Click Finish and your new project will appear in the project window, in the left hand pane.  You can open out the tree lists by clicking on the +, and close them by clicking on the -.

Creating a Program

The next step is to create a program file.  A program file is also called source code.  In Java, every source code file must be associated with a class.  I will talk more about classes later in the course.  For now you just need to know that creating a program file is called creating a new class in eclipse.  You can create a new class in two ways, both of which are equivalent.  Choose whichever you prefer, the end result will be the same.  The first method is from the File menu, choosing New and then Class.  The second is right clicking your project name, LabEx1 in this example, choosing New and then Class.  Both ways bring up the new class window:
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Most of the options involve Java concepts that we have not covered yet, so just accept the defaults.  The one field you must fill in is the class name.  In this case call it Ex1 and hit Finish.  Ignore the warning about using the default package.  The project window now becomes:

[image: image7.png]€ Java - Exi. java - Eclipse SDK.

Bl Edt Souce Refactor Novigate Search Project Run Window Help

g % -0 -Q-  B#H G-

£ Package Explorer 53 Hierarchy| ~ & Outine 53

i AR e
Bt || Public elass Exi ¢

et
8 (default package)

® [J] Ext java
5 B TRE System Lbrary [re1 5.0_12]

)

20 problems 55 Javadoc | Decaration
0 errors, 0 warrings, 0 fos
Description ~ | Resowce | path [ Locaton |

iikable SmartInsert | 111




The central window is the program file, ready for editing.  Some of the Java has already been written for you.  We are finally ready to enter a program and try to run it!

Type in the following program.  The editor is a standard mouse based editor.  You position your cursor with the mouse or arrow keys and enter text.  If you have made a mistake you can use the backspace and delete characters.

public class Ex1 {

public static void main(String[] arg)

{


System.out.println("Hello World");

}

}
Note that some of this code as already been entered for you.  Also note that eclipse will try and help you as much as possible.  It will indent your code to make it easier to read, and also add a } after you have type a { followed by a newline.  Don’t type the } again yourself!  Eclipse will also add a ) after you have type the (, and also the second “ in a string.  Some programmers find this annoying rather than helpful!

Compiling and Running the Program

The next step is to compile the program and then run it if there are no syntax errors.  In eclipse both stages are done together by the run command.  If there are any syntax errors then your program will not be run, but you will be notified of the errors instead.  You choose the Run menu followed by the Run option.  Note that there are lots of different options in the Run menu, ignore the others for now.  Once you select Run, the Run window will appear.  Double click Java Application from the 7 possible choices in the left most window.  The window will change to the configuration window shown below.
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Your workbench can manage several different projects.  The Browse... button will let you choose which project you want to run.  At the moment our choice is easy because there is only one project in our workspace.  Similarly, it is possible for each project to have more than one Main class.  If we have more than one Main class then the Browse... button will let us switch between them.  At the moment the Project and Main class are the ones we want, so press the Run button to bring up the Save resources window:

[image: image9.png]& Save and Launch

Select resaurces to save:

st obies et el

select Al_] [ peselect Al

[ always save resources before launching





This window asks if we want to save the changes we made when editing Ex1.java.  Press OK and the program will finally run, printing Hello World in the lower pane in the project window.  It is possible that the Console tab is not there in the bottom part of the workbench.  To make it visible, go to the Window menu and select Show View and then Console.
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If you didn’t get this far then you must have mistyped something.  Check every letter until you find what it was.

Once you have a Hello World program working, exit from eclipse and start it again, running the Hello World program and seeing the same output.  You should find it much quicker this time!

Next, we are going to make some changes.  Write down what you observe so that we can discuss them in the tutorial.

Making Changes

Change System.out.println to System.err.println.  Run the program again and note what was different.

Remove the semi-colon (;) and run the program.  What happens?  You should get the error window:
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Press the Cancel button.  Your program has a grammatical error (Syntax error), which you must correct first.  Note that the line with the error is highlit in the editor window.  Select the Problems tab to what is wrong..
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Correct the error and try it again.  Note that the red error circle indicates where the compiler first noticed an error.  The actual error may be a line or two before the actual error was detected.

Now remove the [] in the second line and try to run the program.  The program will run but will give the rather confusing runtime error message on the Console tab.

java.lang.NoSuchMethodError: main
Put the [] back to get your programming working again.

Now change “Hello World” to “Goodbye Cruel World”.  What happens?

Finally, delete the words public in front of the word class.  What happens?  What happens if you delete public in front of the word static?

Using the FormatIO Package

Now edit your program so that it looks like this:

public class Ex1 {

public static void main(String[] arg)

{


Console con = new Console();


con.println("Hello World");

}

}

Run it and see what happens.  You should get the error message:

Console cannot be resolved to a type Ex1.java Lab1ex1 line 5

You will have to look at the Problems tab in the output window at the bottom of the project screen.  Remember to Run the program first and then Cancel.

The reason for this error is that we are using some code that is not included in the standard library.  The Console class is part of the FormatIO package.  We need to include this package in our project.  This is done in three stages.

First we must copy the FormatIO folder from ITLib into our filestore on drive H.  Drive H is where you keep your permanent files.  Files on the local machine vanish when you log off.  This is done outside of eclipse.

start – Run  with the command \\fs4.

Then double click on IT Lib.  You will see the FormatIO_7 folder.

Drag this into your folder on your H drive.  Do not put it into your eclipse workspace folder.

The second stage is to create an empty package called FormatIO in our project.  We do this with File – New – Package to bring up the new package dialog box.  We call the new package FormatIO, as show in the screenshot.  Ignore the note about the package name and click Finish.
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The third stage is to import the java files into our project.

File – Import – General - File System, as shown.
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Click Next to bring up the next dialog.
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We browse to find the correct From directory and Into folder.  Filter Types will let us select only the .java files select .java files.  Here is the filter dialog box:
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Click OK and then Finished and the files are copied into your new package.  You can see them in the FormatIO folder in your project in the package explorer.

Now run the program.  We still get the same error!  This is because we have not told the Java program that we are using the FormatIO package.  We need to add the line

import FormatIO.*;

at the front of the program.  The final program is now:

import FormatIO.*;

public class Ex1 {

public static void main(String[] arg)

{


Console con = new Console();


con.println("Hello World");

}

}
Run it this time and it works!  The output appears in a new window that looks like this:
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You will notice that there are 39 warnings, which you can ignore!

Writing to a File

Now add the following two lines that create an output file object and write to it.


FileOut fout = new FileOut("greeting");


fout.println("Hi Ron");

So that the complete program is now:

import FormatIO.*;

public class Ex1 {

public static void main(String[] arg)

{


Console con = new Console();


con.println("Hello World");


FileOut fout = new FileOut("greeting");


fout.println("Hi Ron");

}

}

This program creates a file called greeting and writes a greeting to it.  This file is created in the eclipse\Lab1Ex1 folder.  Find it and open it with WordPad to make sure it contains what you expect.

Reading From a File

We are now going to create a second project and use this project to read from the file we just created.

Create a new project called Lab1Ex2, just like you created the first project.  Create a new class Ex2.  Notice that you project window shows both projects and both classes.  Open up both projects by clicking on the + signs, so that you know where all the components of each project are.  Right clicking on each file gives you the things that you can do with each component.  Now close them up again by clicking on the -.

Type in the following program to Ex2.  Note that you can copy and paste some of it from Ex1.

import FormatIO.*;

public class Ex2 {

public static void main(String[] arg)

{


Console con = new Console();


FileIn fin = new FileIn();


String word = "";


word = fin.readWord(); 


con.println(word);

}

}
You should notice some red syntax error markers.  This is because we have not yet added FormatIO to the project.  We do, this by:

Select FormatIO in project Lab1Ex1.  Just open up the project and left click on FormatIO with the mouse.  Type CTL-C to copy it.

Select Lab1Ex2 and type CTL-V to paste FormatIO in this project.

Type Run – Run as before but note that the Run window will still try to run the project Lab1Ex1.  We need to change this by clicking Browse to the right of the Project field to bring up the project selection dialog box.
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Select LabEx2 to make sure the correct project is run.  You will also have to change the Main class from Ex1 to Ex2.  The program will now run.

When it does it will bring up a file dialog box to let us search for the file:
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This should run and print the word Hi in the Console window.

Finally, change the FileIn definition line to:


FileIn fin = new FileIn("..\\Lab1Ex1\\greeting");

and run again.  The File Chooser dialog will not be shown because we have specified the input file exactly.

Further Work

If you have time, experiment with the buttons on the eclipse project window.  Run the mouse over them to find out what they do.  You can also resize the component windows of the eclipse project screen.  Just move the mouse over the screen slowly until the cursor changes to a resize cursor and then drag and drop the boundaries between the windows.
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